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CHAPTER 1 DOCUMENT DESIGN AND LAYOUT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When producing documents in Word, it is important to consider the 
overall design and layout of your document. A well-designed 
document will be attractive to the reader and will improve 
readability. 

There are several design principles that you should be aware of 
when designing documents to ensure that you create 
professional-looking documents. 

In this session you will: 

 gain an overview of the different types of business 
documents 

 gain an understanding of the different types of software 
available for producing business documents 

 gain an overview of who prepares business documents 

 gain an overview of the various ways of speeding up 
document production 

 gain an understanding of aspects to consider when 
developing document standards 

 gain an understanding of meeting organisational 
requirements 

 gain an understanding of the four basic principles of 
design 

 gain an understanding of document layout 

 gain an understanding of white space 

 gain an understanding of typeface 

 gain an understanding of visual elements 

 gain an understanding of rules and borders 

 gain an understanding of headings 

 gain an understanding of page layout 

 gain an understanding of computer graphics 

 gain an understanding of colour 

 gain an understanding of document writing aspects. 

INFOCUS 
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TYPES OF BUSINESS DOCUMENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A business must communicate with its 
customers, employees, suppliers, the 
government, and other businesses. This 
communication is mostly done through a variety 

of business documents. As a result there are a 
large number and variety of documents produced 
by businesses. 

A good way to understand the types of business documents produced in organisations is to examine 
the needs and requirements of the various parts of an organisation, and to group documents 
according to the functions performed. 

Management 

Management requires documents that help it make business decisions and help it keep the business 
running. These types of documents include: 

 Production reports 

 Sales reports 

 Meeting minutes 

Sales and Marketing 

Sales and Marketing require documents that help promote the business and its products to the 
customers. These types of documents include: 

 Price lists and order forms 

 Product brochures 

 Sales reports 

 Bulk mail-outs to customers 

Human Resources 

Human Resources deal with a variety of matters regarding employees. They require a very broad 
range of documents including: 

 Job descriptions 

 Employment forms 

 Training manuals and guides 

 Job procedures 

Manufacturing and Production 

Manufacturing and Production produce the goods and services sold by the business and require 
documents that help them produce these goods and services on time and in the most cost-effective 
manner. The types of documents they require include: 

 Production reports 

 Supplier price lists and forms 

 Product specifications and procedures 

Administration and Accounts 

Administration and Accounts are responsible for ensuring that the day-to-day operation of the 
business proceeds smoothly, that customers are invoiced, that bills are paid, that money is collected 
and banked, and the like. They require a variety of documents including: 

 Memos, faxes and letters 

 Sales reports 

 Accounting reports 
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CHOOSING APPROPRIATE SOFTWARE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The large number of documents required for 
businesses to operate can be produced by a 
variety of software packages and applications. In 
fact, many of the documents can be produced by 

more than one type of software application. It is 
useful to know about the role and function of the 
various software applications. 

Type of 
Document 

Typical Software 
Application(s) 

Level of 
Sophistication 

Comments 

Production reports  Spreadsheets 

 Database 

 Word processing 

 Specialised production software 

Low For internal communication 
only 

Sales reports  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

Low For internal communication 
only 

Meeting minutes  Word processing Low For internal communication 
only 

Price lists  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

 Desktop publishing software 

Medium For internal use as well as 
external communication to 
customers 

Order forms  Word processing 
Desktop publishing software 

Low For customer use 

Product brochures  Word processing 

 Desktop publishing software 

High For customer use 

Merge letters  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

Medium Used to communicate to 
customers 

Job descriptions  Word processing Medium For prospective job applicants  

Employment forms  Word processing 

 Desktop publishing software 

Low For internal use only 

Job procedures  Word processing Low For internal use only 

Supplier price lists  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

Low For internal use only 

Product 
specifications 

 Database 

 Word processing 

 Accounting software 

Medium For customer use 

Memos, faxes, 
letters 

 Word processing Low For internal and external 
communication 

Accounting reports  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

Low For internal use 
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WHO PREPARES BUSINESS DOCUMENTS? 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With such a diversity of business documents in 
use today, and with a variety of software 
applications available to create these documents, 
it is obviously not possible for one person or 

department to assume total responsibility for 
document preparation. So, who does prepare 
documents in a business? 

Standard Business Documents 

Standard business documents are relatively simple in layout, and are authored, printed and 
distributed by the same person within a company. These documents are usually memos, letters, 
faxes, minutes of meetings, and the like. The focus is more on the content and the subject matter 
than on the layout and overall appearance of the document. 

These would form the bulk of the documents produced within a company. 

These documents are usually produced on a personal computer or laptop and printed on the 
author’s printer. Increasingly, these documents are circulated internally via email rather than 
through the mail system. 

Large companies often have directives that specify how these documents should be laid out. In 
small to medium companies, however, the look and layout of these documents is less formal and 
left to the discretion of the author. Many authors simply use the templates found in word 
processing applications to assist them in the layout of these types of documents. 

Specialised Business Documents 

Specialised business documents are by nature more complex and difficult to produce. These 
types of documents are usually colour brochures promoting the company and its products, 
annual reports for shareholders and investors, and the like. Often they incorporate pictures and 
artwork (graphics), and are produced as full-colour documents on high quality paper. 

These documents are usually produced by a team of people. Some of these people work within 
the company, while others are contracted by the company to perform a specific job. For example, 
the content is usually prepared by people within the company that are expert in the products and 
services of the company. However, these people do not usually have professional design and 
printing skills so these aspects of document production are outsourced to an external company 
that specialises in layout, design and printing. 

Generally, there are three steps to the production of these types of documents. 

1. The text (also referred to as the ‘copy’) is prepared by the subject experts within the 
company. 

2. The text, relevant pictures and general information about the purpose of the document is 
handed over to a designer to lay out the design, choose the appropriate colours and 
fonts, and so on. 

3. The completed document is then provided in an electronic format to a printing company 
that prints the document in the quantities required by the company. 

Naturally, there should be someone within the company who manages and coordinates this 
process. If these documents are for sales and marketing purposes, it is usually someone from 
the marketing department who undertakes this role. 
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SPEEDING UP DOCUMENT PRODUCTION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Most software applications that are used to 
produce business documents contain a number 
of features that can speed up the production of 
documents. There are also things that can be 

done within a company to ensure efficient and fast 
document production. Some of the software 
features and company tasks are detailed below. 

Features Found In Software 

Macros 

Originally, macros were simply recorded keystrokes that could be stored and executed over and over 
again. These were used for the production of documents, or parts of documents, that remained the 
same from document to document. The keystrokes, such as a series of sequential steps to complete a 
specific task or perform an action, were recorded when the first document was created. They could 
then be replayed to create more of the same types of documents. Today, macros still perform the 
same role. However, they are now based on sophisticated programming commands and languages 
and, while still relatively easy to use, offer much more power than earlier keystroke macros. 

Themes 

Themes let you create professional-looking documents with a co-ordinated set of colours, fonts and 
backgrounds in a flash. By applying one of the 40 built-in themes you can change the overall look of 
your document immediately. To make the best use of themes, however, you will need to apply styles 
(via the Home tab) to the various elements in the document. 

Templates 

One of the most tedious tasks in document production is designing the layout and overall presentation 
of a document. A template allows you to create a document based on an existing design and can save 
much production time. Templates can also be created from an existing document. The existing 
document is converted into a template and the design of that document can then be used to produce 
future documents. 

Styles 

Longer documents require consistency in the look of their headings, text, tables, and the like. Styles in 
word processing applications allow you to store a set of formatting attributes and then apply that 
formatting to different parts of the document. For example, you can create a style for main headings 
that consists of a range of formatting attributes, such as a specific font style, font size, adjusted 
paragraph spacing, etc. You can then apply that style to any text that you want to use as a main 
heading. If you later want to change the way those headings look, you only need to change the style 
and all of the headings will automatically update. Styles can save a considerable amount of time in 
document production. 

Building Blocks 

You can recycle content that you use constantly in your business, such as contracts, agreements, 
procedures and the like, by creating and using building blocks. For example, you might save your 
company’s contact information as a building block in the Quick Parts gallery, and whenever you 
require that information, you can simply open the Quick Parts gallery and select the desired building 
block. 

Speeding Up Document Production 

Guidelines and standards 

One of the most time-consuming aspects of document production is deciding how you want it to look – 
what fonts to use, colours, margin settings, headers, footers, and so on. It is extremely beneficial for 
any company to have a set of procedures and guidelines that define these aspects of document 
production for authors. Every company, even the smallest, will decrease production time by having a 
set of standards in place. In addition these should be incorporated into a standard set of company 
templates (see above) which can be easily accessed by authors. 
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ESTABLISHING DOCUMENT STANDARDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

It is important for all companies, both small and 
large, to have a set of guidelines and standards 
in place for document production and handling. 
These guidelines ensure a consistent look and 

feel amongst the documents, allow new employees 
to become quickly acquainted with document 
production, and convey a professional image of the 
company to its customers and clients. 

Things To Consider When Developing Document Standards 

Storage 

It is important that company documents can be located and accessed by relevant people. 
Documents can be stored on a personal computer or on a network server. If company documents 
are stored on a personal computer, and if those documents are to be made available to other users, 
then the documents should be stored in shared folders that are accessible to other users on the 
network. Generally, it is advisable for public documents to be placed on a network server if one 
exists. Some liaison with the network administrator may be necessary to ensure that document 
authors have appropriate access rights to the network. 

Folder and file naming 

It is important that the company implements a standard for file and folder naming. Using proper 
guidelines ensures that important documents can be found easily in the future. A handy technique 
used in document production is to include the file name and folder path somewhere in the 
document. This can be in the header, the footer, on the front or last page, or even in the document 
properties. The desired method should be clearly detailed in the company guidelines. 

Templates 

Detailed information should be placed in the guidelines with regard to what templates are available 
for document production. There should also be instructions explaining how the templates are to be 
used, where they can be accessed, and appropriate information detailing what can and what can’t 
be altered in the templates. 

Company logos, colours and general branding 

Most companies have an established logo, colour scheme and other form of branding. The 
guidelines should clearly indicate what these are, what the minimum and maximum sizing for logos 
is, the placement of logos, the colour of the text, and other branding issues. 

Styles 

The document guidelines should contain information about the size of font, line and paragraph 
spacing, and indents that are to be used for the body text (the general text), headings, table text, 
figure text, captions, and other text in the document. 

Output 

The document guidelines should include detailed information about how the document should be 
produced. For example, many computer printers will print in draft mode and quality mode. The 
guidelines should indicate when it is appropriate to print the document in quality mode (which is 
more expensive and sometimes slower). Also, it is increasingly popular to transmit documents 
electronically via email. The guidelines should indicate when documents are to be printed on paper 
and when they are to be transmitted electronically. 

Review of standards 

It is not possible to lock in standards forever – needs and technology are changing too fast to make 
this possible. Consideration should be given, therefore, as to how frequently the standards will be 
reviewed and how the amendments will be provided to the user. 
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MEETING ORGANISATIONAL REQUIREMENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Word processing programs such as Microsoft 
Word allow you to create a huge range of 
documents, from the personal letter to complex 
organisational reports. While most personal 

documents are designed from personal taste, an 
organisation’s documents should be produced 
according to the image that the organisation wants 
to convey to the public. 

Organisational Logo 

An organisation’s logo is usually a special graphic image that is used to identify the organisation to the 
public. These images are stored digitally as image files, and can easily be imported into word 
processing programs such as Microsoft Word. Organisational logos are generally found on the first 
page of a letter (known as the letterhead), or they may be found at the top (header) or bottom (footer) of 
every page. 

Organisational Colour Scheme 

As well as an organisational logo, each organisation will further brand itself by having specific corporate 
colours that are used throughout their documents. Usually the corporate colours will be the same 
colours as those used in the logo. These colours may be used in business documents, brochures, 
flyers and other advertising material to further help identify the organisation to the public. Microsoft 
Word allows you to apply colour to text, for example, as well as to apply and customise document 
themes. Document themes contain colour schemes and you can customise these to match 
organisational requirements. As colour printing becomes less expensive, more documents are being 
printed with coloured elements, such as shapes and borders, which reflect the organisation’s corporate 
colours.  

Established Guidelines 

Large organisations often have established guidelines in place for producing organisational documents. 
These guidelines will most likely be found in the company’s Style guide or similar document. These 
guidelines are developed so that employees can produce consistent documents that convey the 
organisation’s image. 

Styles 

In word processing programs you can create documents that have a consistent look and feel by using 
styles. A style is a stored set of formatting attributes that can easily be applied to text. Many 
organisations will have a range of styles that you are required to use when producing business 
documents and these may be contained in the organisation’s templates (see below). Information about 
using styles will also be contained within the company’s Style guide or similar document. 

Templates 

Templates are often used in organisations for most standard business documents and are made 
available to all users. Each template will already contain the prescribed layout and formatting as well as 
the organisation’s styles. Many templates already contain standard or boilerplate text to reduce the time 
it takes the user to create a document. These templates will usually be available on the organisation’s 
intranet or network. 

Organisational Details 

With organisational documents it is important to be able to locate them easily. Information such as the 
file name, file location, author, date, and/or time is often found in the footer (bottom) of the first page or 
each page of the document and this information will help to locate electronic copies of documents. 
Again, the established guidelines for the organisation will spell out requirements. 

Copyright Legislation 

It is important that document content adheres to copyright laws and requirements. Organisations that 
produce documents that fail to meet copyright guidelines are often the subject of law suits. Again, the 
established guidelines for the organisation or your supervisor should indicate what can be placed in a 
document and how it should be presented. 
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THE FOUR BASIC PRINCIPLES OF DESIGN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Robin Williams, in her excellent book on design, 
The Non-Designer's Design Book, has identified 
four basic principles to assist users in the design 
of effective and striking publications: contrast, 

repetition, alignment and proximity. These 
interconnected principles should be applied to all 
documents that you create to ensure effective and 
professional-looking documents. 

1 Contrast 

Contrast is used to create interest on the page or in 
the document and occurs when two elements are 
different. Contrast demands that you take risks and 
be bold. If two elements are sort of different, then you 
have conflict rather than contrast. For contrast to be 
effective the elements must be very different. 

For example, you can contrast large fonts with small 
fonts, old fonts with new fonts, a thin line with a thick 
line, a cool colour with a warm colour, wide spacing 
with narrow spacing, a small picture with a large 
picture, and much more. 

Alignment 

Aligning items on a page creates a strong visual 
connection and implies order and cohesion. The 
basic rule of alignment is that nothing should be 
placed on the page arbitrarily – every item on a page 
should have a visual connection to something else on 
the page. The purpose of alignment is to unify and to 
organise, and it is often alignment that determines the 
mood or look of a publication – formal, humorous, 
serious, and the like. 

2 

Repetition 

In life, repetition is boring, but in document design, repetition is everything! The basic principle here 
is that you repeat some element or aspect of your design throughout the entire document or 
publication. This is done in a variety of ways. For example, you can make all of your main headings 
the same, create a consistent header or footer on each page, indent the body text in the same way 
throughout the publication, and more. 

Use repetition to provide a theme and consistency throughout your publication – but avoid going 
overboard and allowing repetition to become annoying or overwhelming. In some ways repetition is 
the antithesis of contrast – yet good documents have both principles working together. 

Proximity 

Many designers tend to place design items too far apart – often items are placed at different corners 
of a page. Placing related items together creates a strong visual unit and helps the eye of the reader 
to find the information they’re looking for. Grouping related items in close proximity to each other 
creates an impression of organisation. 

To achieve proximity you should avoid placing too many differing and separate elements on a page 
and avoid placing items in the corners or the middle of the page. Equal amounts of white space 
should also be avoided. 

 

Further reading: The Non-Designer's Design Book by Robin Williams (Peachpit Press, 1994) 

3 

4 
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UNDERSTANDING DOCUMENT LAYOUT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To understand how to lay out a document 
effectively, you need to understand how readers 
read information, as well as how to control the 
flow of text on a page. When reading a 

document, readers will scan a page in a specific 
way and text flow will determine the readability of a 
document. Similarly, alignment of text will dictate 
the warmth (or otherwise) of your documents. 

Controlling Text Flow 

When looking at a page, readers will generally scan the page across the top from left to right, then 
scan down to the bottom left and across to the bottom right. This is shown in illustration 1 below. 

The scanning pattern of readers can be varied by including visual elements on the page, such as 
pictures, graphics, tables and the like. In illustration 2 below, two visual elements have been 
introduced to change the scanning pattern of the reader. 

Placing strong visual elements at the top left and bottom right of the page, as shown in illustration 3, 
captures the reader’s attention and often forces them to read the text in between. Their eyes are 
drawn back and forth between the visual elements forcing interest and curiosity. 

Text Alignment 

Text alignment can be used to set the tone of your document. Basically, you have four alignments to 
work with: 

1. Justified – even alignment at left and right – is used to provide an official tone to your document 

2. Left – with ragged right edge – sets a casual tone to your document 

3. Centred – with left and right ragged edges – should only be used for one-page fliers and the like 

4. Right – with ragged left edge – should only be used for specialised purposes as it is very difficult 
to read. 
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UNDERSTANDING WHITE SPACE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

White space is a term used to describe the area 
on a page or in a document that is blank, that is, 
contains no text, picture, table, or other item. It is 
important to include areas of white space in a 

document, as this improves the readability of your 
document, especially where there are long blocks 
of text. There are a number of ways of controlling 
the amount of white space in your document. 

Page Margins 

Every page of your document contains four margins – top, bottom, 
left and right. These margins can be individually set from the edge 
of the page. The greater the margin, the larger the area of white 
space you will have on the page. The left margin is often set at a 
higher value than the right margin in documents and this is handy 
as it enables the reader to make notes in the margin if required. 

You can adjust the document’s page margins by clicking on 

Margins  in the Page Setup group on the Page Layout tab. 

Spacing Between Lines 

Some documents, such as draft reports or essays, are often 
produced with text that is double-spaced. Double-spacing these 
documents makes them easier to review, especially where 
annotations or notes need to be written on the page. In Word you 
can set the spacing infinitesimally. 

You can adjust the double-spacing of text by clicking on Line 

spacing  in the Paragraph group on the Home tab. 

Spacing Between Paragraphs 

Large slabs of text can be easier to read by manipulating the 
spacing between paragraphs. You can normally set spacing 
before a paragraph and also after a paragraph. Spacing between 
paragraphs is usually measured in points – 72 points are 
equivalent to 1 inch (2.5 cm). 

You can adjust the spacing between paragraphs by increasing or 
decreasing Before and After Spacing in the Paragraph group on 
the Page Layout tab. 

Indenting 

While page margins are measured from the page edge, indents 
are measured from the margin. Normally text appears between 
the left and the right margins. However, you can increase the 
spacing from the left or right margins by changing the paragraph 
indentation. Indentation can also be set to negative values so that 
they go back into the margins. 

You can adjust the indentation of paragraphs by increasing or 
decreasing the Left and Right Indent in the Paragraph group on 

the Page Layout tab. 

White Space – Pros and Cons 

Pros 

 Improves readability 

 Allows reader to make notes and 
annotations 

 Attracts interest 

Cons 

 Increases document size 

 Higher printing costs due to page size 
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UNDERSTANDING TYPEFACE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the past, printers used metal typefaces to 
determine the style of printing. In computers 
typeface refers to the type of font (the style of 
printing) and usually the size of the font used. 

The typeface of your document often dictates the 
legibility of the document. Typeface can also reflect 
the tone of your document – formal, happy, sad, 
comic, and the like. 

Fonts 

Fonts refer to the style of print used. There are thousands of fonts available today. On your computer, 
fonts are installed in Windows and are made accessible to programs such as Microsoft Word. Factors to 
consider with your document are font category, font size, and font type. 

You can view all available fonts and change the font used by clicking on the drop arrow for Font 
 in the Font group on the Home tab. 

Font Categories 

There are several categories of fonts: 

 

Old style 
fonts 

Old style fonts developed from handwriting and 
are characterised by serifs – tiny tails that help 
the letters flow into one another. These fonts are 
used in larger publications such as reports, 
essays and books. 

Cambria 

Times New Roman 

Bookman Old Style 

Sans Serif 
fonts 

Designed to appear uncluttered, sans serif 
fonts don’t have the tails that serif fonts do. Sans 
serif fonts tend to be slower to read. They are 
usually used for documents that do not need to 
be read from beginning to end – e.g. brochures 
and flyers. 

Calibri 

Arial 

Century Gothic 

Script 
fonts 

Script fonts are designed to look like 
handwriting. 

Lucida Handwriting 

Bradley Hand ITC 

Display 
fonts 

Display fonts are often used for display or 
decorative purposes, often in headings. They 
are excellent for posters or flyers. 

Comic Sans MS 

Broadway 

Castellar 

Wingdings Wingdings are a special font that contain 
pictures rather than letters or numbers. They are 
used to place symbols such as telephones, a 
computer mouse, arrows, squares, scrolls, 
pointing fingers, and the like in documents. 







Font Size 

The size of a font is measured in points (there are 72 points in an inch). In Microsoft Word 2010, the 
default font for a new blank document is Calibri and the size is 11 points. 

The comfort factor with font sizes varies with age and reading skill. New readers, especially children, 
prefer larger sizes (around 15 points). Competent adult readers prefer sizes between 10 and 13 points, 
while older people prefer sizes between 13 and 14 points. 

Font Style 

Fonts also may have certain styles associated with them. The style may be normal (default), italic, bold, 
underline, or bold and italic. Bold and italics are used for emphasis. Italics are often used for short 
quotations (2 – 3 lines), unfamiliar foreign words, titles (books, songs, poems), and passing reference to 
inanimate objects (rockets, ships, planes, trains, cars). 
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UNDERSTANDING VISUAL ELEMENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Traditional documents, especially those created 
on typewriters, consist entirely of text. With word 
processing programs, however, it is possible to 
incorporate visual elements into your 

documents, such as photographs, logos, drawings, 
graphics and charts. These help to break up text, 
facilitate technical explanations, and generally 
make your documents more visually-appealing. 

Visual elements are objects inserted into a document that are not text. They include graphics, 
photographs and drawings. 

Graphics 

Graphics is a widely used term and can virtually be applied to all visual elements. In Microsoft Word 
the term is mostly used to refer to graphs or charts from a spreadsheet application, or self-contained 
images such as logos, SmartArt or Clip art. Clip art are usually entire pictures (such as cartoons) or 
drawings and are stored as separate files in a library or gallery. 

You can insert graphics by using the tools on the Illustrations group on the Insert tab. Once 
inserted, you can position and edit selected graphics by using the tools on the Picture Tools: 
Format tab. 

Photographs 

As the name suggests, these are photographs that have either been scanned into the computer or 
captured on a digital camera. Photographs are stored in files (usually JPG files). 

You can insert photos by clicking on Picture  on the Illustrations group on the Insert tab. 

Drawings 

Drawings can be created with Microsoft Word using the Shapes tool  and consist of combinations 
of lines, squares, circles, and other shapes to form composite objects such as diagrams, flow charts, 
organisational charts, logos, and the like. Unlike the other visual elements, they are created within the 
document rather than inserted, pasted or imported from a file format. 

You can insert and create shapes and drawings by clicking on Shapes  on the Illustrations 
group on the Insert tab. 

When To Use Visual Elements 

Visual elements can be used to: 

 enhance or explain aspects introduced in the text 

 add relief (usually comic) 

 fill a large area that would otherwise be empty 

 make the document more attractive to the reader 

 reduce the amount of textual explanation required. 

Where To Place Visual Elements 

Visual elements can be placed anywhere on a page in a document. In Microsoft Word they can be 
placed on the page and in line with the text with the text wrapping around them, behind the text, or 
floating on the page. 

Visual elements can be resized to look comfortable within the constraints of the overall layout of the 
page and document. However, be aware that reducing an element too much may render it illegible 
and useless. 

Some publications have visual elements in consistent positions, either at the top or bottom of the 
page. If this is the case it is usually expected that the element will include a caption. In Microsoft 
Word you can use captioning to apply automatic caption and figure numbers. 

Visual elements can provide balance to your document page. 
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